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Foreword 
 
The contents of this appendix were adapted from the FHWA DRIP User’s Guide (1) and 
are provided in support of PART 3, Chapter 1 and Appendix SS of the Design Guide.  
DRIP can be used to perform the necessary calculations for the hydraulic design of 
permeable bases and edgedrains, as well as for the design of aggregate and geotextile 
separator layers.  This program is available in the Design Guide software under the 
Tools/Additional Programs menu.  
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Under this contract, DRIP Version 2.0 and a revised user’s guide were developed.   
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APPENDIX TT:  DRAINAGE REQUIREMENT IN PAVEMENTS 
(DRIP) MICROCOMPUTER PROGRAM USER’S GUIDE 

 

1.0 INTRODUCTION 

Brief History of DRIP Development 
 
Moisture-related pavement distresses have long been recognized as a primary contributor 
to premature failures and accelerated pavement deterioration.  The Federal Highway 
Administration (FHWA) provides design guidance for drainage in its manual numbered 
FHWA-TS-80-224, “Highway Subdrainage Design.”  Under a study known as 
Demonstration Project No. 87, or simply “Demo 87,” the FHWA Pavement Division 
developed a comprehensive effort to provide design guidance for handling water that 
infiltrated into the pavement structure from the surface.  That study resulted in the 
production of the Participant Notebook for Demonstration Project No. 87.  Engineers 
needed a concise and user-friendly microcomputer program that replicates the subsurface 
drainage design procedures in the Participant’s Workbook for Demonstration Project No. 
87.  Also, because of the increasing use of the SI unit system, there was a need for the 
program to incorporate both SI and pound-inch (U.S. Customary) units.   
 
Under a contract from the FHWA (contract No. DTFH61-95-C-00008) Applied Research 
Associates, Inc., developed the original version of the microcomputer program titled 
“Drainage Requirements in Pavements (DRIP) Version 1.0.” DRIP was finalized in 1997. 
 
In 1998, a new National Highway Institute course (NHI Course No. 131026) titled 
“Pavement Subsurface Drainage Design” was developed to further improve the guidance 
on pavement subsurface drainage design, construction, and maintenance.  DRIP Version 
1.0 was integrated into this course to perform hydraulic design computations.   The 
program has since been used in the industry and has received excellent reviews.   
 
However, several valuable suggestions were made by DRIP users to further improve the 
program.  The suggestions mainly pertained to improving design input screen graphics, 
variable plot displays and outputs, and the user’s manual.  Certain key drainage 
calculations and plotting options were also suggested to enhance DRIP’s technical 
capabilities.  In addition, there was a need to upgrade the program to be compatible with 
the computing environments prevalent today. 
 
Thus version 1.0 of the program was modified and enhanced by the ERES Division of 
ARA under FHWA Contract No. DTFH61-00-F-00199).  The enhanced version 2.0 was 
finalized in 2000. 
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DRIP Capabilities 
 
The salient features of DRIP are described below.  Each of these features can be executed 
independently from within the program. 
  
Roadway Geometry Calculations 
 
Using this program feature, the user can compute the length and slope of the true 
drainage path based on the longitudinal and transverse grade of the roadway, as well as 
the width of the underlying base material.  The user can perform these calculations for the 
two common roadway cross-sections commonly encountered—crowned and 
superelevated (uniform slope) sections. 
 
Sieve Analysis Calculations 
 
The effective grain sizes (Dx), total and effective porosities, coefficient of uniformity and 
gradation, and coefficient of permeability can be computed for any user-entered gradation 
using this program feature.  Plots of the gradations on semi-log and FHWA power 45 
templates can also be obtained from this program screen. 
 
Inflow Calculations 
 
The amount of moisture infiltrating the pavement structure from rainfall and meltwater 
can be computed using this program option.  The surface infiltration calculations can be 
performed using two different approaches—the Infiltration Ratio approach and the Crack 
Infiltration approach.  Meltwater computations can be performed for a variety of soil 
types and pavement cross-section depths. 
 
Permeable Base Design 
 
The program offers two permeable base design options—depth-of-flow and time-to-
drain.  These methods allow the user to design an open-graded base that can handle the 
inflow entering the pavement structure. 
 
Separator Layer Design 
 
Using this program option, the user can design two types of separator layers—geotextile 
and aggregate separator layers.  Based on the gradations of the proposed permeable base 
and the subgrade under consideration, the program also verifies whether a separation 
layer is required at all. 
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Edgedrain Design 
   
Two types of edgedrains can be designed using this program option—geocomposite of 
fin drains and pipe edgedrains.  The program calculates the edgedrain capacity and the 
outlet spacing required. 

New Features in DRIP Version 2.0 
 
DRIP 2.0 retains the capabilities of the earlier version of the program but makes the 
execution more efficient and incorporates all the new features explained in the previous 
section.  DRIP 2.0 incorporates several significant advancements in user interface and 
capabilities: 
 

• Win32 support.  Fully compatible with Windows 95/98/NT. 
• Normal and Expert modes.  Normal mode warns users of potential errors during 

input and offers suggestions on proper program use.  Expert mode suppresses 
these warnings, allowing experienced users of program the ability to edit data 
more quickly, without continually acknowledging warning screens. 

• Tabbed property pages.  The individual data input and analysis screens employed 
in DRIP Version 1.0 have been updated/improved and are now displayed using a 
property page format.  This new format allows a more intuitive navigation 
through the various program screens.  Each property page can be accessed by 
means of the tabs displayed continually along the top of the DRIP client area. 

• Analysis type selection.  The DRIP program allows the user to select the type of 
roadway geometry, inflow calculation method, permeable base analysis type, 
separator layer analysis type, and edgedrain type.  The selections available under 
each of these categories are usually located in the upper left corner of the 
respective property page in the form of radio buttons.  By making the appropriate 
selection, the user can customize the analysis performed on each property page.  
For example, to perform time-to-drain design of permeable bases, the user should 
select the “Time to Drain” radio button on the Permeable Base property page.  
The program then configures the page to display appropriate inputs and outputs 
for this analysis.   

• Hyper-linked input data fields.  In the DRIP program, certain variables appear on 
multiple property pages.  The hyper-linking feature is aimed at preventing the 
novice user from inadvertently entering different values for the same DRIP 
variable on different property pages.  By clicking the left mouse button on a 
hyper-linked variable (identified by an underline beneath it), the program 
transports the user to a property page where this variable should most logically be 
configured.   

• Improved graphics.  The graphics that illustrate drainage input variables have 
been improved. 

• Summary screen.  A linked summary list is now present on the left side of the 
DRIP client window.  This list allows the user to get an update on the status of the 
current DRIP session. 
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• Context sensitive help.  Right clicking on any variable in the DRIP program 
displays a short description of that variable. 

• Improved online help.  The complete DRIP user’s manual is now available and 
searchable online and from within the program. 

• HTML analysis summary.  A formatted report on the inputs used and outputs 
calculated in the current DRIP session is available using the File | Export 
Summary command.  This information contained in this file is in standard HTML 
format and can be read and edited using standard browser applications, word 
processing programs, or spreadsheet software. 

• Print analysis summary.  A well-formatted printed report displaying the inputs 
used and outputs calculated in the current DRIP session is available using the File 
| Print Summary command. 

• Improved gradation library.  The importing and saving of sieve gradation analysis 
has been improved.  The program allows descriptive file naming to save input 
gradations for future use. 

• Additional sieve sizes.  Particle sizes determined from hydrometer tests can now 
by used by the DRIP model. 

• Improved graphing.  Graphing of grain size distributions and sensitivity analysis 
plots has been simplified.  Graphs generated by DRIP can now be imported 
directly into other Windows® applications or saved as JPEG files. 

• Power 0.45 and semi-log plots.  Sieve analyses can be viewed on either power 
0.45 or semi-log plots. 

 

2.0 ORGANIZATION OF THIS APPENDIX 

 
This appendix is organized so that both the novice and experienced DRIP users can 
navigate easily through the program’s many different features.  The content of this 
manual is also available with the program as online help.  In an effort to minimize 
repetition, topics that are identical in different parts of the program are usually only 
covered once in detail; when repeated, the reader is referred to previous explanations. 

Getting Started 
 
In Getting Started, the user will learn about the minimum system requirements for 
running DRIP 2.0 on a personal computer or network, DRIP 2.0 installation, and the 
usage of DRIP 2.0 to perform pavement drainage analysis and design. 

General DRIP Operation 
 
This section provides an in-depth guide on how to use DRIP 2.0, including file handling, 
data input, data analysis, and report generation.  Operation of the DRIP plotting 
package—DripPlot—is also fully described. 



 TT-5

Examples Problems 
 
This section provides example problems to assist the user in developing a proficiency in 
the use of the program.   

Sensitivity Analysis 
 
This section discusses the design sensitivity to changes in various parameters, which can 
be used both as a design reference and as an example of the type of detailed analyses that 
can be performed using the DRIP program.  
 

3.0 GETTING STARTED 
  
Getting started with DRIP 2.0 is easy, especially if you already have installed the Design 
Guide software program.   To install DRIP, go to the Tools/Additional Programs menu 
on the menu selection tool bar in the Design Guide software, and select the DRIP icon.  
This action will install the program automatically.  Once installed, the program can be 
accessed from within the Design Guide software using the same menu selections. 

System Requirements 
 
To run DRIP 2.0 on your computer, the following minimum hardware and software 
requirements must be met: 
 

• IBM-compatible PC with at least a Pentium processor. 
• 32 MB of RAM. 
• 15 MB of available hard disk space. 
• One CD-ROM drive (for installation only). 
• Monitor capable of 800x600 resolution. 
• Mouse or compatible pointing device. 
• Printer (optional). 

 
Also, the computer on which DRIP 2.0 is installed must be running Microsoft Windows 
95/98 or Windows NT 4.0 operating system (or a compatible later version).   
 
Basically, if all the requirements to run the Design Guide software are satisfied, then the 
system requirements for DRIP 2.0 will be satisfied. 
 

4.0 GENERAL DRIP OPERATION 

 
When the user starts the DRIP program, a splash screen appears briefly, followed by the 
DRIP client window shown in Figure 1.  The DRIP client window has the following 
features: 
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• A menu bar across the top, which includes the File menu, the Options menu, and 

the Help menu. 
• A program summary column on the left side of the screen that displays all the 

important DRIP outputs.  The summary information is continually updated as the 
analysis progresses. 

• A series of six tabs arranged from the left to right titled Roadway Geometry, 
Sieve Analysis, Inflow, Permeable Base, Separator, and Edgedrain.  When 
selected, these tabs display the respective property pages.  Each property page has 
the following common elements: edit boxes for data input, on-screen graphics 
describing the problem, and calculator and/or graph icons for output computation.  
In addition, some property pages have module-specific analysis options, e.g., the 
Edgedrain property page allows the user to choose between pipe edgedrain or 
geocomposite edgedrain analysis types.  All the hydraulic design and analysis in 
DRIP takes place within these property pages. 

 
DRIP has many features that can be used from anywhere within the program.  These 
include file or project actions such as saving and printing, as well as the functions of 
certain function keys, and on-screen buttons.  This chapter describes many such features 
that are available throughout the program.  In addition, a detailed description of the 
functionality of each tabbed property page is also provided.  The description of the DRIP 
program features and operation is broken down and presented under the following section 
headings: 
 

• General DRIP features – DRIP icons, context sensitive help, hyper-linking, error 
checking. 

• DRIP Menus – File handling, Help, and Options. 
• DripPlot – Graphing and plotting package for DRIP.  
• DRIP Property Pages – Tabbed property pages each containing one of the six sub-

processes required for a complete drainage analysis. 
• Project Summary – Summary of important input and output data for the program.   
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Figure 1.  The DRIP client window. 

General DRIP Features 
 
DRIP has many features to assist the user in operating the program, including special 
icons, context sensitive help, hyper-linking of variables, and input data error checking.     
 
DRIP Icons 
 
There are three of types of icon buttons in DRIP – Calculator, Graph, and Balance.  The 
icons are illustrated and explained below. 
 

   Calculator icon: Allows the user to perform a calculation based on 
the inputs provided by the user.  This icon is activated (turns 
colorful) only when all the necessary inputs for a given calculation 
are configured.  For example, in Figure 1, the parameter W can be 
calculated by pressing the calculator icon only after the inputs b 
and c have been configured.  In certain instances, pressing the 
calculator icon opens a dialog box (e.g., heave rate determination 
in the Inflow property page), or transports the user to an 
appropriate property page where inputs to calculate the parameter 
under question should be configured (e.g., the Dx calculation in the 
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Separator property page).  Calculator icons appear on every 
property page. 

 

  Graph icon: Generates appropriate graphs for the property page in 
which it is located and opens DripPlot to display them.  The graph 
icons appear on Sieve Analysis, Permeable Base, and Separator 
property pages. 

 

 Balance icon: Checks whether the design criteria for the aggregate 
and geotextile separator layers are satisfied on the Separator 
property page. 

 
DRIP Help 
 
Context-sensitive help can be accessed for any program variable by right-clicking the 
mouse button while the cursor is on top of that variable.  A small help box will appear 
superimposed above the DRIP dialog box, giving a short description of the variable in 
question. 
 
Hyperlinking in DRIP 
 
Most of the property pages in DRIP are interconnected.  As a consequence an input on a 
certain page may be an output on another page.  Therefore, a given variable can appear 
on multiple property pages.  For example the parameter, W, appears on both the Roadway 
Geometry and Inflow property pages.  However, it is actually an output on the Roadway 
Geometry property page and an input in the Inflow property page.  This could lead to 
some confusion in the mind of the novice user on where to enter the value for parameter 
W.  In order to address such situations, a hyperlink was provided for all variables that 
appear on multiple screens.  All hyperlinked variables are identified by an underline 
beneath them.  If a hyper-linked variable is selected with a left-click of the mouse, the 
program will jump to where that variable should most logically be entered.  By editing 
the variable on the analysis page suggested by DRIP, the user can avoid inadvertently 
entering different values for the same variable on different screens.  Although the user is 
not required to use this feature, it is highly recommended, especially for novice users and 
also when an analysis utilizing only a few of the property pages offered by the program is 
attempted. 
 
Error Checking 
 
DRIP displays a warning when a dependent variable is about to be changed.  DRIP also 
warns the user when data input is inappropriate, such as entering a negative unit weight 
for a material.  While this feature is helpful for a novice DRIP user, these warnings can 
become an annoyance for the experienced user.  To aid the experienced DRIP user, an 
Expert Mode is available.  When DRIP is running in the Expert Mode all warning and 
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informational dialog boxes are suppressed, allowing the user to enter potentially incorrect 
data, or to edit a dependent variable.  Only experienced users should attempt to use DRIP 
in the Expert Mode.  The Expert or Normal mode selection is made under the Options | 
Mode menu item.  When first run, DRIP defaults to the Normal mode, with all the 
warning and informational dialog boxes activated. 

DRIP Menus 
 
Menus in DRIP are used to control file handling, help, and program options.  All menu 
items can be accessed from any of the tabbed property pages. 
 
File Menu Options (Including Print Summary) 
 
The File menu controls file handling, printing, and summary output.  When DRIP is first 
started, the program opens into a new DRIP project or session file.  This new DRIP file is 
empty except for a few default input parameters.  At this time the user should either open 
a previously generated DRIP project file by using the File | Open menu command or 
name the newly created DRIP project file by using the File | Save menu command. 
 
File | New – Creates a new DRIP project file, clearing all user input data from the 
currently active project file.  There can only be one active project file for each DRIP 
client window.  Creating a new DRIP project file with the File | New command within an 
active DRIP client will close the currently active DRIP file.  A newly created DRIP 
project file is unnamed.  It is suggested that the newly created DRIP project file be named 
using the File| Save menu command.  While each DRIP client window allows only a 
single DRIP project file to be active, it is possible to have several DRIP client windows 
running on one computer.   
 
File | Open – Opens a previously saved DRIP project file (identified by a *.drp 
extension).  The current active DRIP project file is closed without saving.   The File | 
Open dialog box is of the MS Windows Explorer® style, allowing the user to rename, 
copy, and paste files within it.  Figure 2 illustrates the File | Open  dialog box.  
 
File | Save – Saves the current active DRIP project.  When this option is selected, a 
dialog box, such as the one shown in Figure 3 opens prompting the user to save the 
current DRIP project.  The user may choose to save a DRIP project with a file extension 
other than the default *.drp extension.  However, this is not recommended since files 
saved with an alternative extension will not appear automatically in the dialog box when 
the File | Open menu command is executed.  If the current active DRIP project has been 
previously saved, the File | Save menu command will not open the “Save generated DRIP 
data file” dialog box, but instead will overwrite the previously saved DRIP project file. 
 
File | Save As – Same as File | Save menu command except that this command will 
always open the “Save generated DRIP data file” dialog box shown in Figure 3. 
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Figure 2.  The file open dialog box. 

 

 
Figure 3.  File save dialog box. 

File | Export Summary – Creates a summary of the active DRIP project file.  The format 
of this file is Hypertext Markup Language (HTML) and it can be viewed using any Web 
browser, spreadsheet, or word processing program. Since DRIP analyses are modular in 
nature, the summaries provided are also divided into subsections—Roadway Geometry, 
Sieve Analysis, Inflow, Permeable Base, Separator Layer, and Edge Drain.  A summary 
for a particular subsection is output only if data has been entered for that analysis or that 
analysis has been completed.  If no data has been entered, only the primary header of that 
analysis module is provided.   
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To export the project summary to an HTML file the following steps need to be followed: 
 

1. Select the File | Export Summary command from the File menu.  A “Create 
DRIP summary file” dialog box similar to the one shown in Figure 4 pops up 
prompting the user to enter to enter a file name under which the DRIP project 
file summary will be saved.  

2. Save the summary file to an appropriate directory on the computer by 
specifying a file name.  Note that the summary files are automatically saved 
with an extension of *.htm. 

 

 
Figure 4.  Dialog box to save project summary information. 

Once the summary information is saved to a file, it is automatically displayed on the 
computer screen using the default HTML browser application.  The information can be 
printed directly from this application using standard print commands.  Alternatively, the 
summary information file can also be opened with any standard word processing or 
spreadsheet programs that reads HTML documents, e.g., Microsoft Word® or Microsoft 
Excel®.  The advantage of using a word processing or spreadsheet application is that they 
enable the user to custom format the information contained in the file.  Further, tabular 
data is stored using HTML tables, and therefore can be utilized directly by a spreadsheet 
applications such as Microsoft Excel® to create custom plots of DRIP data.  This 
capability is in addition to the intrinsic plotting package (DripPlot) provided with DRIP. 
 
File | Print Summary – Prints the output summary information.  The following steps need 
to be followed to print the summary information. 
 

1. Select the File | Print Summary command from the file menu.  A “Create DRIP 
summary file” dialog box similar to the one shown in Figure 4 pops up   
prompting the user to enter a file name under which the DRIP project file 
summary will be saved. 

2. The user can choose to either save the summary information to be printed to a file 
by clicking the Save button (recommended) or can opt not to save it by pressing 
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Cancel button.  Note the summary files are automatically saved with an extension 
of *.htm. 

3. After the file Save or Cancel operations are performed, the program automatically 
opens the “Print” dialog box shown in Figure 5 from where the user can select the 
printer to send the output to (the printer choices displayed will obviously be a 
function of the user’s local environment).   

 
Note that the output will be printed using default format settings.  If the formatting of the 
default output layout needs to be changed, the user will need to open the saved summary 
file using standard word processing or spreadsheet programs to edit the file. 
 

 
Figure 5.  The Print dialog box. 

File | Exit – Ends the current DRIP session.  If the user selects this option or clicks on the 
Close icon on the client window, DRIP will generate a dialog box prompting the user to 
save the current project file.  From here the user can choose to save the file, exit the 
program, or cancel the dialog box and return to the program.  If the user chooses to save 
the file, the dialog box shown in Figure 3 will appear to facilitate data storage.   
 
Options Menu  
 
The Options menu sets the program options available in DRIP—Units, Mode, Sensitivity, 
and Plot Scale. 
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Options | Units – This menu command allows the user to toggle between metric and 
English standard units.  All input and output variables in DRIP are converted when using 
the Units menu command.  A checkmark appears next to the unit type in use.  English 
units are used as default in DRIP. 
 
Options | Mode – Determines the level of information and warning dialog boxes 
employed by DRIP.  These dialog boxes inform the user when a program action or 
function deviates from those recommended by this manual.  While this feature prevents 
the novice user of the program from making mistakes, it can become cumbersome for the 
experienced user.  When the Normal menu item is checked, all warnings and information 
dialog boxes are displayed.  The Expert mode suppresses all but the most important 
warning boxes, allowing the experienced user to make informed changes of input data, 
both dependent and independent.  DRIP defaults to the Normal mode when started. 
 
Options | Sensitivity – This option is specific to the Time to Drain and Depth of Flow 
analyses performed within the Permeable Base property page.  It allows the user to 
determine which sensitivity analyses are to be performed during permeable base design.  
The choices are length, slope, permeability, inflow, drain (degree of drainage), thickness, 
and porosity.  If any of these menu items is checked, a corresponding sensitivity analysis 
is performed during the permeable base design.  DRIP defaults to performing sensitivity 
analysis for all appropriate input variables. 
 
Options | Scale – Determines whether the horizontal scale of the sieve analysis plot is 
logarithmic or Power 0.45.  If the former is chosen, logarithms of the sieve sizes are 
plotted against the percent passing to produce a semi-log plot.  If the latter is chosen, the 
sieve sizes are raised to the 0.45 power and plotted against the percent passing to yield an 
FHWA power 0.45 chart.  DRIP defaults to a power 0.45 scale for all gradation plots. 
 
The semi-log plot is best used when plotting materials with large amounts passing the 
#200 sieve for which hydrometer analysis data is available.  When these gradations are 
plotted on an FHWA power 0.45 chart, the plot is not as visually appealing.  Semi-log 
plots are also useful when multiple gradations with widely differing sieve sizes are being 
plotted on the same chart, such as in aggregate separator layer design. An example 
comparison of a fine-grained material plotted using the Power 0.45 and semi-log scales is 
presented in Figure 6 and Figure 7.  Note that the gradations used in both figures are 
identical.  The advantage of using a semi-log plot scale for this gradation is obvious from 
these figures. 
 
On the other hand, when plotting coarse-grained materials on a semi-log chart, the 
gradations have a tendency to fall within one or two logarithmic cycles, making the plot 
more difficult to read.  The Power 0.45 scale is better for plotting coarse-grained 
materials.   
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Figure 6.  Sample subgrade gradation plot on FHWA power 0.45 chart. 

 
 
 

 
 

Figure 7.  Sample subgrade gradation plot on a semi-log chart. 
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Help Menu  
 
DRIP employs Windows HTML Help.  The contents of this manual are available online 
and can be accessed by selecting the Help | Contents command from the menu.  Context-
sensitive help can be accessed from anywhere within the program by pressing the F1 
function key.  The DRIP HTML help is fully searchable by contents, index, or keyword.  
The contents of the help file can be printed directly using the standard print options 
provided. 

DripPlot 
 
DripPlot is a companion program to DRIP that creates plots of gradations, aggregate 
separator design, and sensitivity analysis for permeable bases.  The information on the 
operation of DripPlot is provided below. 
 
DripPlot does not contain file handling or data editing capabilities.  Changes to the 
plotted data should be made using DRIP, and the results re-plotted with DripPlot.  Once a 
plot is generated, the user may alter the plot’s appearance.  DripPlot allows the editing of 
titles, legends, font sizes, scales of the vertical and horizontal axes, line types, line colors, 
and line thicknesses. 
 
Plots generated by DripPlot can be saved either as device independent bitmaps (*.dib) or 
as JPEG files (*.jpg).  This allows the user to import data into other Windows programs 
for report preparation.  The user may also copy a DripPlot graph using the Copy menu 
command or shortcut key (control-C) and paste the graph directly into any Windows 
program that allows cutting and pasting. 

DripPlot Menus 
 
The DripPlot menu contains several commands that are common to almost all Windows® 

applications.  A short summary of these commands is included for completeness.  Menu 
commands that are unique to DripPlot are discussed in detail. 
 
File Menu 
 
File | New – Opens another window with the currently plotted screens.  This allows the 
user to have multiple windows of the same plot open.  This feature is used primarily to 
view plots with differing scales, legends, titles, and so on. 
 
File | Save as Dib File – Saves the current plot as a device independent bitmap.  Saving a 
file as a Dib allows the user to import this plot into another Windows® application.  The 
file is saved as it appears on the user’s screen, including size, line color, and titles. 
 
File | Save as Jpeg File – Save the current plot as a JPEG graphic file.  Saving a file as a 
Jpeg allows the user to import this plot into another Windows® application.  The file is 
saved as it appears on the user’s screen, including size, line color, and titles.   
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File | Print – This menu command prints the current plot.  By default, the plot is printed 
in portrait mode, with the margins set in File | Print Page Setup. 
 
File | Print Preview – This command displays how each plot will look when printed. 
 
File | Print Setup – Allows the user to select which printer to user, as well as edit that 
printer’s properties such as paper source, paper size, and orientation. 
 
File | Print Page Setup – Calls the Print Page Setup dialog box, which is shown in Figure 
8.  The dialog box sets the margins used when printing a DripPlot graph.  Valid inputs in 
these boxes range from 0 to 100, and represent the distance from the top and left margins.  
For example, a value of 10% for the Top Margin means that the top margin will end 10% 
from the top of the page.  A Bottom Margin of 60% means the bottom margin begins 
60% from the top of the page.  The net effect in this case is that the plot will take up 50% 
of the page. 
 
 

 
Figure 8.  Print page setup. 

 
Edit Menu 
 
The Edit menu currently has a single menu command, which is Copy.  The Copy 
command allows the user to copy the current plot onto the Windows® clipboard and to 
directly paste that plot into any applications that accept Windows® bitmaps. 
 
View Menu 
 
The View menu commands allow the user to change the basic look of the DripPlot 
application.  View | Toolbar toggles whether the shortcut toolbar is displayed beneath the 
DripPlot menu.  The View | Status Bar toggles whether the status bar is displayed along 
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the bottom of the DripPlot Window.  The status bar gives a short description of each 
menu item and displays whether the Num-lock, Cap-lock, and Scroll-lock keys are set. 
 
Window Menu 
 
The Window menu is designed to arrange and navigate among the plots generated by 
DRIP.  At the bottom of this menu is a list of plot files currently open.  Any plot can be 
brought to the foreground by selecting that plot name from among the menu options. 
 
Window | New Window – Creates a new plot with current DRIP data.  Used to recreate a 
modified plot. 
 
Window | Cascade – Arranges plots one on top of the other, in a manner similar to that of 
a deck of playing cards.  Each plot is slightly offset from the one directly above and 
below. 
 
Window | Tile – Arranges plots side by side in the DripPlot window. 
 
Window | Arrange Icon – Arranges minimized plots along the bottom of the DripPlot 
window. 
 
Chart Menu 
 
The Chart menu is used to modify the appearance of DRIP plots.  DripPlot is designed to 
be a simple, straightforward plotting package.  It is not completely customizable.  If a 
user wishes to make highly customized plots, it is suggested that the information from 
DRIP be output using File | Export Summary to create an HTML summary file.  This 
summary file can be imported directly into most standard graphing packages. 
 
Chart | Titles and Labels – This command allows the user to edit the axis label and plot 
title text.  The user can also change the font size of the all labels and titles.  The “Titles 
and Labels” dialog box with sample graph and axes titles is shown in Figure 9.  The 
default font sizes for the titles are also shown in the figure.  Once the user is finished with 
entering the desired option values on this screen, the changes can be accepted by pressing 
the OK button. 
 
Chart | Lines/Legends and Scale – This command allows the user to edit the legend 
labels and their font size, line color, line type, and line thickness.  For graphs that do not 
involve gradation plotting, it also allows the user to adjust the minimum and maximum 
values displayed on the X- and Y-axes.  The tick marks can also be adjusted for scaling 
the axes.  The “Lines/Legends and Scale” dialog box is shown in Figure 10.   
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Figure 9.  Title and Labels dialog box. 

 

 
Figure 10.  Lines/Legends and Scale dialog box. 

 
When using the above-referenced dialog box, keep in mind: 
 

• Five separate legend entries appear in the box, which is the maximum number of 
individual series that can appear on a single DRIP plot.  For plots with fewer than 
five series, the additional edit boxes are disabled.   

• The Line Color edit boxes control the color of the plots generated by DRIP.  The 
standard line thickness used by a plot generated by DRIP is 2.  However, different 
line thicknesses (from 0 to 10), types (solid, dotted, dashed, and dashed-dot), and 
colors can be used to identify different series.   
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• For the sensitivity plots, although the program allows the maximum value for the 
X-axis to be changed to any number, the plotted data might not be extend over the 
entire range.  This is because the data plotted in the sensitivity charts is 
precomputed for realistic ranges of the independent value.  These ranges are 
hardcoded into the program and cannot be changed.  However, the minimum X-
value can be changed to any level to increase the resolution of the plotted graphs.   

DRIP Property Pages 
 
DRIP has been arranged to flow smoothly from beginning to end of the design process.  
This has been accomplished by breaking the entire drainage design process into six sub-
processes and developing a tabbed property page for each: Roadway Geometry, Sieve 
Analysis, Inflow (with the Meltwater sub-screen), Permeable Base design, Separator 
layer design, and Edgedrain design.  The user can access any of these property pages by 
selecting the appropriate tab along the top of the DRIP client window.  The layout of the 
property pages on the DRIP client window (see Figure 1) suggests a logical left-to-right 
flow of drainage design, which is recommended.  However, the program has the 
flexibility to allow the user to start at any point within the program and to use only a few 
of the program components including the use of only a single property page.  While the 
property pages can be utilized in a stand-alone manner, they are somewhat 
interdependent in that the inputs on one page can be taken from the calculations on 
another.  The interdependencies of the DRIP property pages are shown in  
Figure 11. 
 

Roadway Geometry

Sieve Analysis
Base (required)

Subgrade (required)
Separator (optional)

(Select one)
Crack Infiltration
Infiltration Ratio

Meltwater
(Optional)

Separator Layer (Select one)

Aggregate Separator (plot available)
Geotextile Separator

No Separator (plot available)

Permeable Base (Select one)

Depth-of-Flow
Time-to-Drain (Barber/Sawyer or

Casagrande/Shannon)

Inflow

Gradation
Plots

Plot for
Aggregate
Separator

Edgedrain (select one)

Pipe
Geocomposite

Sensitiv ity
Analysis

plots

 
 

Figure 11.  Interdependencies of DRIP property pages. 
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The Sieve Analysis, Inflow, Permeable Base, Separator, and Edgedrain screens are 
actually multiple property pages in one.  By selecting a specific analysis type using the 
radio buttons located in the upper left-hand corner of the property page, the analysis 
performed by that page can be changed.  For example, on the Inflow property page the 
user can choose either the Crack Infiltration method or the Infiltration Ratio method by 
selecting the appropriate radio button.  On the Permeable Base property page, the 
analysis can be set either to the Depth-of-Flow or the Time-to-Drain method, the 
Separator property page can design either pavements without or with a separator layer 
(aggregate or geotextile), and the Edgedrain property page can be used to design either 
pipe or geocomposite pavement edgedrains.  In addition, a number of other dialog boxes 
are accessible from within certain property pages.  For example, a dialog box for the 
estimation of the quantity of meltwater using Moulton’s chart is available from the 
Meltwater property page.   
 
A number of plots are available from the DRIP property pages including 1) depth-of- 
flow and time-to-drain sensitivity plotting, accessible from the Permeable Base property 
page; 2) meltwater inflow plotting, accessible from the Inflow property page; and 3) 
aggregate gradation plotting, accessible from the Separator layer property page or the 
Sieve Analysis property page. 
 
Input and Output 
 
DRIP uses standard Windows edit boxes within each property page to display input and 
output values, which allows the user to input a value for any parameter after positioning 
the screen cursor over the appropriate edit box and clicking the left mouse button.  The 
user can then type the input value from the keyboard.  In many cases, however, it is 
desirable to let DRIP calculate the parameter value based on user-provided input values 
for other parameters.   
 
Calculator icons beside the parameter labels identify cases where the variable should be 
calculated by the program.  Calculator icons often are accompanied by an equation that 
indicates which parameter values must be input.  When the required input values have 
been provided, the calculator icon will become enabled, or “activated”; an active 
calculator icon is blue in color.  By positioning the screen cursor over an active calculator 
icon and clicking the left mouse button, the value is calculated and displayed in the edit 
box.  Thus, edit boxes are used as the primary means of both input and output.   
 
An alternative method for navigating to the calculator icon is to press the Tab key until 
the desired button has the focus (i.e., until a faint dotted line appears around the button 
text).  Once the button has the focus, hitting the space bar selects the button. 
 
Even when it is desirable to let the system calculate a value for a specific parameter, the 
user always has the option to type a value into the edit box.  To permit this feature, the 
program diligently checks for data conflicts to maintain consistency within a design and 
integrity of the program.  Thus, typing a value for a parameter that should be calculated 
may cause conflicting values for other parameters to be erased. 
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A list of parameters used in this program is included at the end of this appendix as 
Appendix UU.1, “Standardized Nomenclature.” 
 
Roadway Geometry 
 
Although DRIP operates in a modular manner and the design process can be performed in 
any order, it is suggested that the user access the Roadway Geometry property page first.  
The Roadway Geometry property page screen is shown in Figure 12.  On the upper right 
side of the screen are two graphics representing the available options—a roadway with 
crown in the centerline and a roadway that slopes in the same direction on both sides of 
the centerline.  Indicate which geometry best fits the design situation by clicking the 
appropriate radio button.  The equation for width of drainage path W reflects the 
geometry selection, as will the profile graphic in the middle right side of the screen.   
 
To calculate W, the user must first provide values for the parameters b, the width of 
pavement surface, and c, the distance from the pavement shoulder to the edge of the 
permeable base, by entering this data in the appropriate edit box.  When values have been 
supplied for both parameters, the calculator icon beside the parameter W will become 
activated.  Clicking on this icon will cause the value for W to be calculated using the 
equation shown.  In the same manner, when values are provided for longitudinal slope S 
and cross slope SX, the calculator icons for resultant slope SR and resultant length of 
drainage path LR are activated. 
 
The calculator icons become activated whenever all data values that are required to 
evaluate the respective equations are available.  The user always has the option to type in 
a value for the parameter rather than use the equation to calculate it.  However, doing so 
may cause the program to erase values of other parameters (to avoid inconsistencies). 
 
For example, assume that the user has provided values of 9.3 m and 1.2 m for parameters 
b and c, respectively.  Selecting the calculator icon yields a W value of 5.85 m.  Now 
proceed to provide values of 0.05 and 0.03 for S and SX, respectively, and calculate values 
of 0.0583 for SR and 11.37 m for LR.  Now manually edit the value of W, rounding it up to 
6 m.  Doing so erases the value of c, because the combination of b and c that are provided 
cannot result in a W value of 6 m.  The program also erases the value of LR, because the 
value of 11.37 m does not reflect the new design parameter that was provided.  This 
process of erasing data requires the user to recalculate values that reflect new inputs, 
thereby adding to the integrity of the final design.  It also prevents the user from 
mistakenly assuming that values of dependent parameters are still valid. 
 
A flowchart showing the data flow in the Roadway Geometry property page is presented 
in Figure 13. 
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Figure 12.  Roadway Geometry property page. 
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Figure 13.  Flowchart for the Roadway Geometry property page. 
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Sieve Analysis 
 
The Sieve Analysis property page, shown in Figure 14, is used for gradation analysis and 
to input other material properties for the base course, separator, and subgrade layers.  The 
spreadsheet-style grid on the left side of the property page is used for entering and editing 
sieve analysis data.  Sieve data may be entered in this grid in any order, and cells may be 
left blank if data is not available for a particular sieve size.  Two types of sieve analysis 
data entry forms, Range and Value, are available to the user.  The Range analysis, 
selected by the corresponding radio button near the top left side of the property page, 
allows the user to input a range of sieve data that a particular material is bracketed by.  
The Value analysis requires the user to input a single value at sieve sizes for which data is 
available.  The numbers entered are the percent passing a particular sieve, by weight, and 
therefore should range from 0 to 100.  For example, 100% passing should be input as 100 
and 55.3% passing should be input as 55.3. 
 

   
Figure 14.  Sieve Analysis property page. 

When all of the sieve data has been entered, the user can select the calculator button 
located in the Gradation Analysis box to perform a grain size distribution analysis.  If the 
entered gradation data is not consistent, DRIP warns the user by changing the font color 
of the value in question to red.  For example if the user entered 50% passing the #4 Sieve, 
and 100% passing the #8, the number 50.0 would be highlighted in red since it is 
physically impossible to have such a gradation. 
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DRIP allows the user to enter both the sieve and hydrometer analysis data when 
determining grain size distribution.  It is important to include the sieve size where less 
than 10% passes so that the program can properly determine D10.  It is also important to 
include the sieve where at least 85% of the material is passing so D85 can be properly 
determined. When the user selects the calculator button in the Gradation Analysis box, a 
grain size distribution analysis is performed to calculate effective sizes at different 
percentages (D10, D12, D15, D30, D50, D60, D85), percent passing the #200 sieve, CU 
(coefficient off uniformity), and Cc (coefficient of curvature or gradation). 

 
After the calculator button is selected in the Gradation Analysis category box, the 
Gradation plot button becomes active.  Selecting this button calls DripPlot and displays a 
grain size distribution plot.  The program defaults to a Power 0.45 horizontal scale, but 
the user may change this to a semi-log scale using the Options | Plot Scale menu 
command.  On the main DRIP window, the gradation of the AASHTO #57 material is 
plotted in Figure 15 on a Power 0.45 chart as an example. 
 

 
Figure 15.  Example output of a value input sieve analysis. 

 
In addition to entering sieve data, DRIP allows the user to select materials from the 
resident Material Library.  When a material is selected from the Material Library, all of 
the sieve and property data saved for that material will be entered in the appropriate edit 
boxes, overwriting the data already present.   
 
The user can also save custom gradation data to the Material Library along with other 
material property information such as unit weight, porosity, and effective porosity by 
following these simple steps: 
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1. Select the type of layer—base, subgrade, or separator—for which data will be 
entered.  This can be done by selecting the appropriate radio button on the 
Sieve Analysis property page. 

2. Select either the Range or Value data entry form and enter the desired 
gradation data. 

3. Click on the Add button in the Material Library box.  Assuming that the input 
data does not contain inconsistencies, an “Add Gradation to Library” dialog 
box appears (see Figure 16).  If there is an error in gradation data entry, the 
inconsistent data appears in red colored font and will need to be corrected. 

4. Enter a text-based file descriptor that will be also used as a file name.  This 
file name will have the extension .sgd attached to it and will be saved in the 
GradFiles folder in the DRIP directory.  Avoid using any DOS file control 
characters (*,/,\,:,?) when describing the material.  

 

 
 

Figure 16.  Add gradation to Material Library. 
 
After the material is saved to the Material Library, that description will appear in the 
library pull down list box.  If the user edits this file by entering new numbers in the Sieve 
Analysis spreadsheet, the material type will return to <user defined>.  The <user 
defined> material type is a temporary name and will not be saved if a specific material is 
selected from the Material Library. 
 
Materials that are added to the Material Library remain in the library until the file is 
removed using the Remove button or deleting the appropriate *.sgd file from the 
GradFiles subdirectory.  When a user starts entering data in the sieve analysis 
spreadsheet, the name of the material changes to <user defined>.  It is possible to have 
separate <user defined> entries for the base, subgrade, and separator layers. 
 
Besides gradation analysis, the Sieve Analysis property page requests several other user 
inputs.  These values can be entered directly or calculated using empirical formulae.  
Permeability, k, of a layer can be calculated using Moulton’s empirical formulation, 
which requires particle size and porosity information.  DRIP allows the user to compute 
porosity after the unit weight and the specific gravity of the material is entered.  A more 
accurate estimation of porosity can be gained through laboratory testing.  If such data are 
available, they should be used in place of the empirical formulae. 
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Two analysis methods are supplied for computation of the effective porosity, ne—the 
water loss method and the water content method.  As the user clicks the appropriate radio 
button for each method, the equation changes accordingly.  For fine materials such as 
subgrades, the water content method is recommended.  In order to use this method to 
estimate ne, the approximate value of the water content should be entered. 

 
For coarse materials such as permeable bases, the water loss method is recommended.  
To use this method, the user should first select the Water Loss Method radio button.  The 
“Water Loss” dialog box similar to the one shown in Figure 17 opens automatically. This 
dialog box contains a table that shows values for water loss for P200 of 0%, 2.5%, 5%, 
and 10%, for either gravel or sand materials.  The user should indicate the type of fines 
(filler, sand, or clay) contained in the material by clicking the appropriate radio button.  If 
the user has already calculated P200 for the given material, that value will appear as a 
column in the grid shown in Figure 17.  Two water loss values, one for sand and other for 
gravel, are automatically computed and displayed in the dialog box in the P200 column.  
The user should then select one of the water loss values corresponding to the material 
being analyzed with the screen cursor.  Once the selection is made and the “Water Loss” 
dialog box is closed by pressing the “OK” button, the selected value appears in the Water 
Loss edit box on the Sieve Analysis property page. 
 

 
Figure 17.  Water Loss dialog box. 

 
Inflow 
 
The next recommended step in a drainage analysis is to calculate the pavement 
infiltration due to rainfall and meltwater (where applicable).  This calculation is handled 
in the Inflow property page.  The user can perform this calculation using the Infiltration 
Ratio method or the Crack Infiltration method by selecting the appropriate radio buttons.  
By default the program uses the latter method.  Adding meltwater to the inflow 
calculation can be enabled or disabled by means of the Include Meltwater check box. 
 
The Inflow property page configured for the Infiltration Ratio method is shown in Figure 
18.  In the Infiltration Method category box, the user can indicate whether the surface is  
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Figure 18.  Inflow (Infiltration Ratio) property page. 

 
asphalt or concrete by clicking the appropriate radio button.  The range of acceptable 
values for infiltration coefficient C is noted below the edit box.  The user may type an 
estimate of the value in the edit box or click the x icon to automatically fill the edit box 
with the midpoint value.  Changing the surface type will erase any displayed value of C 
and will require the user to provide a new value. 
 
The lower portion of the screen allows the user to type in a value for the rainfall rate R, 
which can be approximated from the rainfall map displayed in online help when the 
calculator icon is pressed.  By default, the program displays the map for a 2-year, 1-hour 
storm, which is recommended in FHWA report number FHWA-SA-92-008.  The user 
can opt to display instead the map for a 1-year, 1-hour storm, which is recommended in 
FHWA-TS-80-224.  Both maps show R values in units of in/hr, so if the analysis is 
employing metric units, the user needs to manually convert these values to their metric 
equivalent.   
 
When values have been provided for both R and C, the calculator icon for inflow, qi, is 
activated.  Clicking the icon will calculate qi using the equation shown. 
 
The Inflow screen for the Crack Infiltration method is shown in Figure 19.  When the 
program begins, the crack infiltration rate IC has a default value of 2.4 ft3/day/ft (0.22  
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Figure 19.  Inflow (Crack Infiltration) property page. 

m3/day/m).  Some other input parameter values may already be filled in when the 
property page is first selected if they have been generated by previous inputs and 
calculations.  For example, if the user calculated W = 5.85 m on the Roadway Geometry 
screen using Geometry A and values of 9.3 m and 1.2 m for b and c, respectively, then 
the W edit box will contain the number 5.85 and the edit box for width of pavement WC 
will contain the number 4.65 (or b/2).  Other parameters to be supplied are permeability 
kp of the pavement surface, transverse crack spacing CS, and number of contributing 
longitudinal cracks NC.  NC is generally equal to one plus the number of contributing 
traffic lanes.  When values are provided for all these parameters, the calculator icon for qi 
will be activated, allowing the calculation to be performed.  The user should compare the 
value calculated here to the value calculated using the Infiltration Ratio method, and 
choose the larger number for the sake of conservatism. 
  
Along the same conservative vein, the user may wish to include meltwater in the total 
inflow calculation.  The Inflow property page with the Include Meltwater box checked is 
shown in Figure 20.  The heave rates for different types of subgrade soils can be 
determined by selecting the calculator icon to the left of the Heave edit box label.  A 
“Heave Determination” dialog box such as the one shown in Figure 21 will open.  This 
dialog box presents minimum and maximum heave rates for a variety of soil types with 
different ranges of minus 200 material.  In some cases, the lower bound heave rates are 
the same as upper bound heave rates, indicating that there is very little variability in the 
data.  The user may use this table to estimate a heave rate for a given soil type and 
manually enter it into the Heave edit box, or alternatively obtain the value by clicking on 
the desired row in the table.  If the latter method is used, the midpoint of the selected  
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Figure 20.  Inflow calculation with Meltwater included. 

 
Figure 21.  Heave determination dialog box. 
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range of heave values will automatically appear in the edit box.  In addition to heave rate 
determination, the user should also provide a value of subgrade permeability ksub.  An 
estimate of the subgrade permeability can be directly entered based on laboratory test 
data or can be determined based on sieve data.  Selecting the calculator icon next to the 
ksub edit box returns the user to the Sieve Analysis property page from where this 
parameter can be estimated.  The other parameter required to estimate inflow due to 
meltwater is load of the pavement structure, σ,  which includes loads from both the 
pavement surface and the base.  The user can either directly enter a value for σ, if it is 
known a priori, or can compute it by first entering values for unit weights γp and γb and 
the thickness HS and H of the pavement surface and base, respectively, and then clicking 
on the calculator icon to the left of the σ  label. 
 
When values have been provided for σ, ksub, and the Heave rate, the graph icon for 
meltwater, qm, is activated.  The user can click this icon to display Moulton’s chart for 
estimation of meltwater shown below in Figure 22.  The vertical axis represents heave 
rate, in mm/day, and a red line is drawn to indicate the heave rate value.  The user can 
move the mouse to drag a crosshair along the red line.  The horizontal axis represents 
qm/ ksub .  The curves on the graph represent multiple values of σ, in units of lb/ft2.  The 
values of ksub, σ, and heave rate are displayed at the top of the screen in the required 
units, as is the current position of the cursor with respect to the horizontal axis.  Position 
the crosshair at a graph location indicative of the value of σ, and click the mouse button.  
The value of qm will be calculated and displayed at the top of the screen.  When this 
dialog box is exited, the calculated value will appear in the qm edit box on the Meltwater 
screen. 
 
Example – Meltwater Computation 
 
Assume for this example that the subgrade permeability (ksub) is 100 ft/day, the heave rate 
(Heave) is 0.1 in/day, and the vertical stress on the top of the subgrade (σ) is 200 lb/ft2.  
Enter these values in the appropriate edit boxes and click on the graph icon to determine 
qm.  Moulton's meltwater chart appears on the screen.  On this chart a horizontal red line 
marking the entered heave rate of the subgrade (0.1 in/day) appears.  In order to compute 
the meltwater, the computer mouse can be used to slide the vertical tick line along the 
horizontal red line to the location where σ  is approximately 200 lb/ft2.  When the mouse 
is at the right position the value for qm/ ksub  should read 0.36.  A left click of the mouse 
button will then produce a value for qm of 3.61 ft3/day/ft2.  This value is transported to the 
qm edit box on the Inflow property page when the “Evaluation of the Meltwater Inflow” 
dialog box is closed.  
 

While including meltwater is a conservative approach, engineering judgment may need to 
be exercized in adding this value the pavement infiltration from rainfall – qi.  The 
combined inflow of qi and qm could be unreasonably high in some situations.   

A flowchart illustrating the data flow on the Inflow property page is presented in Figure 
23. 
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Figure 22.  Meltwater inflow computation dialog box. 
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Figure 23.  Flowchart for the Inflow property page. 
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Permeable Base 
 
On the top left corner of the Permeable Base property page, the user may choose whether 
to design the permeable base based on depth-of-flow or time-to-drain criteria by clicking 
the appropriate radio buttons.  It is suggested that total inflow be calculated before 
attempting to perform the base design using the depth-of-flow method.  The Permeable 
Base property page configured for the depth-of-flow method is shown in Figure 24. 
 

 
Figure 24.  Permeable Base (depth-of-flow) property page. 

 
If the left-to-right hydraulic design flow recommended in this manual is followed, values 
for several parameters will already be present on this screen.  For example, SR and LR will 
have been calculated on the Roadway Geometry property page, qi will have been 
calculated on the Inflow property page, and a value for H may have also been provided 
on the Inflow property page.  If these values are not present, they may be manually 
entered in the appropriate edit boxes on this screen.  However, for hyperlinked variables 
(all variables identified with an underline), a more correct procedure would be to first 
identify the appropriate property pages where these inputs should be logically entered, 
and then entering them there.   In addition to these variables, the user will also need to 
provide a value for permeability, k, of the permeable base.  It is recommended in 
hydraulic design practice that this value be obtained directly from laboratory testing.  The 
laboratory k value, if available, can be directly entered on this screen.  Alternatively, the 
user may click the calculator icon located to the left of this parameter to estimate 
permeability based on the gradation of the permeable base aggregate.  This action will 
take the user to the Sieve Analysis property page where the computation can be made.  
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However, it must be noted here that the underlying statistical relationship that estimates 
permeability from the gradation data was derived for materials with a significant quantity 
of material passing the #200 sieve.  Therefore, it may not be very suitable for estimating 
the permeability of open-graded materials, which typically have very low percent passing 
the #200 sieve. 
 
When values have been provided for qi, k, SR, and LR, the calculator and graph icons 
beside the Hmin parameter are activated.  If the calculator icon is clicked at this point, the 
program will use the equations underlying Moulton’s permeable base design chart to 
calculate the minimum required thickness Hmin of the permeable base.  The user should 
check to make sure that the input value of H is greater than the minimum thickness 
required, Hmin.  Clicking the graph icon to the right of the Hmin edit box will plot the 
calculated value of Hmin over a given range of values for the independent parameters 
selected in the Options | Sensitivity menu command.  This allows the user to analyze the 
sensitivity of the design to variations in inputs.  A few typical sensitivity plots for the 
depth-of-flow method are shown in Figure 25 and Figure 26. 
 

 

Figure 25.  Sensitivity analysis for the depth-of-flow method –  base permeability versus 
base thickness. 
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Figure 26.  Sensitivity analysis for the depth-of-flow method – length of flow versus base 

thickness. 

 
 

Figure 27.  Permeable Base (time-to-drain) property page. 
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Once the user is satisfied that the value provided for base thickness H is sufficient to 
handle any possible variations in the design parameters, the capacity of the permeable 
base, qd, can be computed by clicking the calculator icon located to the left of the 
corresponding label. 
 
The Permeable Base property page configured for the time-to-drain method is shown in  
Figure 27.  As with the depth-of-flow method, values would already have been supplied 
for many of the parameters from previous screens.  There are calculator icon buttons 
beside the labels for permeability k and effective porosity ne that the user can click to call 
the Sieve Analysis property page.  Estimated values for these parameters can be 
determined based on aggregate gradation input in that page.  However, it is recommended 
that these values be obtained instead through laboratory testing.  Once the values for k, 
ne, SR, LR, H, and percent drainage U, are supplied, the user can click the calculator icon 
to determine the time required to drain, t.  By default, the parameter t is estimated using 
the Barber and Sawyer equation.  Alternatively, if the Casagrande and Shannon Method 
is the preferred method, the corresponding radio button must be first selected and the 
calculator button next the t parameter clicked to compute the appropriate value.   
 
The resulting value for time t required for drainage from either methods can be compared 
to the table on the right-hand side of the screen to estimate the permeable base quality of 
drainage.  By default, the table displays the quality of drainage based on the AASHTO 50 
percent drained criteria.  Alternatively, the user can choose to display base drainage 
quality based on the pavement rehabilitation manual 85% saturation criteria by clicking 
the appropriate radio button.  To translate these criteria to the current design parameters, 
the user should select the given equation to calculate percent saturation from the values of 
n, ne, and U.  The user may have to modify the value of U until it results in a value of S ≅ 
85%. 
 
As with the depth-of-flow screen, the time-to-drain screen also provides sensitivity 
plotting.  These plots can be accessed by clicking on the graph icon located to the right of 
the time-to-drain parameter t on the Permeable Base property page.  Prior to clicking this 
icon, the independent parameters to be plotted on the horizontal axis against the 
dependent variable t need to be selected using the Options | Sensitivity menu command.  
The sensitivity plots always include the results computed using both Barber and Sawyer 
as well as the Cassagrande and Shannon equations.  A typical sensitivity analysis plot 
from the time-to-drain analysis is presented in Figure 28.  In this figure, the time-to- drain 
parameter t is plotted against the degree of drainage, U.  It can be observed from the 
figure that as the degree of drainage approaches 100 percent, the time to drain increases 
exponentially.  Note that U is expressed as a fraction in the Figure 28. 
 
A flowchart depicting the data flow in the Permeable Base property page is shown in  
Figure 29. 
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Figure 28.  Sensitivity plot for the time-to-drain analysis – time to drain versus degree of 
drainage. 

 
Select

Method

Input qi,
k, LR

Calculate Hmin

Input H

Calculate qd

Output
qd

Input
n, ne, H, k, SR, LR

Select
Criteria

Input
S, n

Calculate U

Input U

Calculate t

Output t

Permeable
Base

Depth-of-Flow Time-to-Drain

Percent Drainage Percent Saturation

Calculate S

 
 

Figure 29.  Flowchart for the Permeable Base property page. 
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Separator Layer 
 
The default screen that appears when the Separator property page is first selected during 
a DRIP session is the configured for the No Separator option.  If a design is performed 
using this option, DRIP will determine whether a separator layer is required.  If instead 
the user wishes to perform an aggregate separator layer design, the appropriate radio 
button located on the left top of the property page should be clicked.  The design screen 
configuration after this selection is made is shown in Figure 30.  The right side of the 
design screen displays particle size criteria to prevent intermixing of layers.  The left side 
of the screen allows the user to input particle size values (e.g., D10, D15, D50, and D85) for 
the permeable base, subgrade, and separator layers.  These values should already be 
present if a complete gradation analysis has been completed for all the materials on the 
Sieve Analysis property page.  If the particle size values are missing for any given layer, 
the user should go to the Sieve Analysis property page to compute these values.  This can 
be done either by clicking the calculator button adjacent to the layer in question or by 
clicking the Sieve Analysis tab on the DRIP client window.  When all the required Dx 
values are configured, the balance and graph icons on the right side of the screen turn 
blue in color.  By clicking on the balance icon, the aggregate separator layer design 
criteria can be checked.   
 

 
Figure 30.  Separator (aggregate separator layer) property page. 

 
After DRIP determines whether the design passes the necessary separator layer criteria, 
left-clicking the graph icon located in the Criteria category box will generate a plot which 
graphically summarizes the design performed.  For an aggregate separator layer design, 
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this plot contains the gradation plots of the subgrade, the base course, and the separator 
layer.  In addition, the numerical values of the design criteria are also plotted and are 
represented using red triangles.  The right-pointing triangles denote the lower limit, while 
the left-pointing triangles denote the upper limit of the desired gradation band for the 
separator layer. 
 
A sample plot generated from the Separator property page is shown in Figure 31.  If a 
chosen separator layer passes all the required design criteria, its gradation should fall 
within this desired band as illustrated in Figure 31.  As with the plots generated on the 
Sieve Analysis property page, either a Power 0.45 or a logarithmic scale can be employed 
for the horizontal axis for this plot. 
 

 
Figure 31.  Separator (aggregate separator) Power 45 plot. 

Figure 32 presents the Separator property page configured for performing a geotextile 
separator layer design.  Selecting the Geotextile Separator radio button enables this 
analysis screen.  As with the aggregate separator layer analysis, the design criteria for the 
geotextile separator layer are also displayed on the right-hand side of the screen.  The 
criteria displayed are dependent on the user’s selections for soil retention criteria (steady-
state or dynamic flow), permeability/permittivity criteria (normal or critical), clogging 
criteria (normal or critical), and the amount of fines in the subgrade material (P200). 
 
Material properties for the subgrade should already be in the edit boxes, carried over 
from the Sieve Analysis property page. After the necessary values have been provided for 
all the subgrade parameters, the calculator icon in the Separator Layer category box 
becomes enabled.  Clicking this button determines the maximum allowable apparent  
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Figure 32.  Separator (geotextile separator) property page. 

opening size AOS of the geotextile and the minimum allowable permeability kmin of the 
geotextile.  Typically, at this stage, in design, a geotextile that satisfies the AOS and kmin 
requirements is selected and its actual permeability is entered in the ksep edit box.  The 
calculator icon for tmax will then become enabled and the maximum allowable thickness 
of the geotextile for permittivity requirements can be computed.  Note that the 
recommendation at the bottom of the screen changes based on the geotextile type. 
 
A flowchart illustrating the data flow of the Separator property page is shown in Figure 
33. 
 
Edgedrain 
 
In the upper left-hand corner of the Edgedrain property page select either the Pipe or 
Geocomposite radio button to identify the type of edgedrain.  The Pipe Edgedrain 
analysis screen is shown in Figure 34.  Typical values for Manning’s roughness 
coefficient, nmanning, for smooth and corrugated pipes are provided on the right-hand side 
of the screen.  If nmanning for the pipe being analyzed is unknown, one of these typical 
values can be adopted by selecting the appropriate check box.  Once the user has supplied 
values for nmanning, slope S of the edgedrain (by default the longitudinal slope), and pipe 
diameter D, the calculator icon for pipe capacity Q becomes activated and can be clicked 
to calculate the quantity. 
 
After calculating Q, there are three options for determining the required outlet spacing.  
The Pavement Infiltration approach is based on the estimated inflow into the permeable 
base; this is the default selection in DRIP.  The Permeable Base approach is based on the 
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Figure 33.  Flowchart for the Separator property page. 

 

 
Figure 34.  Edgedrain (pipe edgedrain) property page. 
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Depth of Flow capacity of the permeable base.  Finally, the Time to Drain approach is 
approach is based on the time required for a specific percentage of the water to drain 
from a saturated permeable base.  Any of these approaches can be selected by clicking 
the appropriate radio button.  When a discharge rate approach is selected in this manner, 
the equation that will be used to compute the outlet spacing is displayed on the screen.  
Edit boxes to enter values required to compute these parameters also appear on the 
screen.  If the user has followed the suggested design flow, values will have already been 
provided for each parameter used.  Therefore, the user can quickly calculate the required 
outlet spacing for each approach and compare the results. 
 
The Geocomposite Edgedrain analysis screen, shown in Figure 35, differs mainly in the 
calculation of edgedrain capacity Q.  For a geocomposite edgedrain, outlet pipe spacing 
Lo is actually a parameter used in the calculation of Q, along with slope S of the 
edgedrain, initial height of flow D1, final height of flow D2, and flow coefficient Cg.  
Thus, the calculation of the outlet spacing Lo is an iterative process.  The program begins 
with an initial value of Lo of 100 m, calculates Q, then iteratively recalculates Lo.  The 
process is repeated until a result is converged upon. 
 

 
Figure 35.  Edgedrain (geocomposite) property page. 

A flowchart of the Edgedrain property page depicting the data flow in this screen is 
shown in Figure 36. 
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Figure 36.  Flowchart for Edgedrain property page. 

Project Summary 
 
The two methods of obtaining analysis reports from DRIP are either to export the project 
summary using the File | Export Summary option or to print it using the File | Print 
Summary option.  The format of exported summary file is HTML, and it can be viewed 
using any Web browser, spreadsheet, or word processing program.  The steps involved in 
exporting and printing project summaries have already been outlined in the section 
dealing with DRIP menus.  Since DRIP analyses are modular in nature, the summaries 
provided are also divided into subsections—Roadway Geometry, Sieve Analysis, Inflow, 
Permeable Base, Separator, and Edgedrain.  A summary for a particular subsection is 
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output only if data has been entered for that analysis or that analysis has been completed.  
If no data has been entered, only the primary header of that analysis module is provided. 
 

5.0 EXAMPLE PROBLEMS 
 
This section contains sample exercises that acquaint the user with the operation of DRIP.  
These examples also illustrate how to perform hydraulic design using DRIP.  As noted in 
PART 3, Chapter 1, drainage analysis and design should be considered as a first step in 
structural design.  The DRIP program is also useful to determine air voids and effective 
grain sizes for a given gradation, which are important materials inputs to the 2002 Design 
Guide software.  The examples presented below will also explain how to perform these 
calculations.  

Example Problem Number 1 
 
Given 
 
A pavement section consists of two 12-ft lanes of 9-in-thick PCC pavement with 10-ft 
AC shoulders on each side with a uniform cross slope (not crowned), and the width of the 
permeable base is the same as the PCC pavement.  The transverse joint spacing is 20 ft.  
The slope in both the longitudinal (S) and transverse (Sx) directions is 2 percent.  The 
permeable base is made up of AASHTO #57 material and has a unit weight of 100 pcf, 
specific gravity of 2.65, and a minimum permeability of 3000 ft/day.  The thickness of 
the permeable base is 4 in, based on construction considerations.  Assume a unit weight 
of 162 pcf for the PCC material.  The subgrade is Georgia Red Clay, which is actually a 
well-graded clayey-silt.  Laboratory tests indicate the particle gradation shown in Table 1 
for the subgrade material and a permeability of 0.0033 ft/day.  Corrugated pipe 
edgedrains having 4-in diameter are used on the project.   
 

Table 1.  Sieve analysis of Georgia Red Clay subgrade. 

Sieve No. Percent Passing 
# 4 
#10 
#20 
#50 
#200 

92 
67 
55 
42 
31 

 
Determine 
 
Use the crack infiltration method to determine inflow.  Check the adequacy of the 
permeable base using the depth-of-flow approach to determine flow conditions.  
Determine the need for an aggregate separator layer and the adequacy of the 4-in pipe.   
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Solution 
 
Prior to starting the analysis, the user needs to select the type of units in which to perform 
the analysis.  This problem will be solved using English units.  This system of units is the 
default option in DRIP and can be selected by checking English under the Options | Units 
menu command.  Once selected, this system of units will be retained throughout the 
analysis unless the user makes a change.  Similarly, the mode of program execution 
(Expert or Normal) can also be selected from the Options menu.  The default is the 
Normal mode, and that will be used in this example. 
 
The problem solution is presented under several different sections.  The arrangement of 
these sections follows the logical left-to-right approach emphasized earlier.  An 
experienced user may, however, solve the problem using a different sequence of steps. 
 
Pavement Geometry 
 
Step 1: Select the Roadway Geometry tab (this is the default program tab) to access the 

corresponding property page.  Select a uniformly cross-sloped pavement section 
by clicking on the Geometry B radio button. 

Step 2: Enter the value of b as 24 ft (2 lanes of 12 ft each).  Since the problem statement 
assumes that the width of the permeable base is same as that of the PCC layer, 
enter the value of c as 0.  Clicking the calculator icon for width of the permeable 
base W results in a computed value of 24 ft. 

Step 3: Enter the longitudinal and transverse slopes in the S and SX edit boxes, 
respectively.  Click the calculator icons for both SR (resultant slope) and LR 
(resultant length) to compute these parameters.  The calculations should yield the 
following values: SR = 0.0283 ft/ft and LR = 33.94 ft/ft.   

 
The completed screen is shown in Figure 37.  The values entered and computed in this 
property page will be saved and carried forward for later use.  Note that as soon as the 
computations are completed on this page, the respective values are displayed on the left 
side of the main DRIP client window.  This screen can be exited by clicking on another 
tabbed property page.   
 
Inflow Computation (Crack Infiltration Method) 
 
Step1: Select the Inflow tab to access the corresponding property page.  Click on the 

Crack Infiltration Method radio button (since this method was required to be 
chosen to estimate inflow). 

Step 2: Retain the default values of 2.4 ft3/day/feet for Ic and 0 for pavement permeability 
kp.  Also retain the values for Wc and W that have been automatically carried 
forward from the calculations performed on the Roadway Geometry page.   

Step 3: Enter the number of longitudinal cracks, Nc, as 3 (Nc = the number of contributing 
lanes + 1 = 2 + 1 = 3).  Enter the given transverse spacing of contributing 
transverse joints Cs = 20 ft.   
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Step 4: Click the calculator icon to compute inflow qi.  This should yield a value of 0.42 
ft3/day/ft2.   

 

 
Figure 37.  Computation of roadway geometry. 

 
The values entered and computed in this screen will be stored and carried forward to 
other screens where they are needed.  The completed Inflow screen is shown in Figure 
38.  The computed inflow value is updated in the summary page. 
 
Meltwater Computation 
 
Step 1:  Activate the Meltwater sub-screen in the Inflow property page by clicking on the 

“Include Meltwater in the inflow calculations” checkbox. 
Step 2: The heave rate (Heave) for the clayey-silt subgrade soil can be determined by 

clicking on the calculator button located to the left of the variable.  This action 
calls up the heave rate table.  The heave rate table shows that the value for clayey-
silt soil is 0.51 in/day.  This value can either be entered manually in the edit box 
on the Meltwater sub-screen or entered automatically by selecting the row 
corresponding to clayey-silt soil type.   
Note :  For materials with large heave rates, the mid-point values may be entered. 

Step 3: Enter the given values for the subgrade permeability (ksub = 1 ft/day), unit weight 
of the pavement surface (γp = 162 lb/ft3), the unit weight of the base material 
above the subgrade (γb = 100 lb/ft3), the thickness of pavement surface (Hs = 9 
in.), and the thickness of the base material (H = 4 in.) in the appropriate boxes. 



 TT-46

Step 4: Click on the calculator icon next to the variable σ to compute the stress imposed 
by the pavement on the subgrade.  This will yield a value of 154.8 lb/ft2. 

 
 
 

 
Figure 38.  Crack infiltration computation. 

 
Step 5: Click the calculator icon for determining the quantity of meltwater (qm).   

Moulton's meltwater chart appears on the screen.  On this screen a horizontal red 
line appears marking the heave rate of the subgrade (0.51 in/day).  Use the mouse 
to slide the vertical tick line along the horizontal red line (0.51 in/day line) to an 
approximate location for a stress of 154.8 psf.  The value for qm/(ksub)0.5 will 
appear in the appropriate box.  When satisfied that the mouse is positioned at the 
proper stress value, click the left mouse button to produce a computed value of 
qm.  For this example, the mouse is positioned to indicate a value of qm/(ksub)0.5 of 
0.91 ft3/day/ft2.  A click of the left mouse button produces a value for qm of 0.05 
ft3/day/ft2.  Press OK to return to the Inflow property page. 

 
The values entered and computed in this screen will be retained and carried forward.  The 
Moulton’s meltwater chart is shown in Figure 39, and the completed meltwater screen is 
shown in Figure 40.  The computed meltwater quantity (qm) is updated in the summary 
page. 
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Permeable Base Design (Depth-of-Flow) 
 
Step 1: Select the Permeable Base tab to access the corresponding property page.  Click 

on the Depth of Flow Method radio button.  Most of the variables such as qi+qm, 
SR, LR, and H already have values carried forward from pervious screens. 

 Note:  The term qi+qm is a summation of the inflow from rainfall and meltwater. 

 
Figure 39.  Moulton’s meltwater chart. 

 
Step 2: Enter the coefficient of permeability of the base (k = 3000 ft/day). 
Step 3: Compute the Hmin by clicking on the calculator icon.  A Hmin value of 0.1437 ft is 

reported, which is lower than the selected permeable base thickness (H) of 0.3333 
ft.  Therefore, the design is satisfied.  
Note:  If Hmin were much greater than H, the designer would make adjustments to the design by 
changing design variables such as base thickness or permeability.  If the base thickness H can be 
revised, this parameter must be changed to be at least equal to the Hmin. 

Step 4: Compute flow capacity of the permeable base (qd) by clicking on the appropriate 
calculator button.  This yields a value of 44.811 ft3/day/ft.  The flow capacity is 
estimated from Moulton’s chart. 

 
A completed design screen for the depth-of-flow design is shown in Figure 41.  The 
values computed here are carried forward to other screens.  The summary box on the 
DRIP client window is also updated accordingly. 
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Figure 40.  Meltwater computation. 

 
 

 
Figure 41.  Permeable base depth-of-flow design. 
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Additional Discussion on Depth of Flow Design 
 
If the user wishes to perform a sensitivity analysis to see the influence of different 
parameters on the required thickness, the graph icon to the right of Hmin variable in Figure 
41 can be clicked.  DRIP internally performs the calculations over a pre-selected range of 
the independent parameter (in this case the required base thickness) and computes 
andplots the dependent variables.  The charts are plotted using the DripPlot.  The 
DripPlot window appears as soon as the graph icon next to the Hmin variable is clicked 
and the following sensitivity plots are displayed: 
 

• Required Base Thickness (Hmin) vs. Pavement Inflow (qi or qi + qm). 
• Required Base Thickness (Hmin) vs. Base Course Permeability (k). 
• Required Base Thickness (Hmin) vs. Resultant Slope (SR). 
• Required Base Thickness (Hmin) vs. Resultant Length (LR). 

 
The user can control the type of plots to be displayed in the DripPlot window using the 
Options | Sensitivity menu command prior to clicking the graph icon.  An example 
sensitivity plot of required base thickness versus permeability is shown in Figure 42.   

 
Figure 42.  Depth-of-flow sensitivity analysis example (H vs k). 

 
The generated plots can be directly saved as image files (jpeg or dib formats) using the 
appropriate options under of the File menu.  Hard copy outputs can also be generated 
using the File | Print command or using the printer icon on DripPlot. 
 



 TT-50

Separator Layer Design 
 
Step 1: Select the Separator Layer tab.  Select the No Separator radio button to evaluate 

the need for a separator layer.   
Step 2: Click on the calculator icon next to the Base Course variable.  This shifts the user 

to the Sieve Analysis property page.  The permeable base is made up of the 
AASHTO #57 material.  The gradation for this material is already in the sieve 
analysis library.  To initialize this gradation to the program, click on the drop-
down material library list box and select AASHTO #57.  Click on the calculator 
icon to determine the particle sizes for D15 and D50. 

Step 3: Select the Separator Layer tab again.  The values of D15=0.2529 in. and 
D50=0.5484 in. appear for the Base Course.   

Step 4: Click on the calculator icon next the Subgrade variable to compute the subgrade 
particle sizes.  The user is returned to the Sieve Analysis property page again and 
the Subgrade radio button is automatically activated.  Select the Value radio 
button and enter the subgrade gradation in the grid on the left-hand side of the 
property page.  Compute the D50 and D85 by clicking on the particle size 
calculator icon. 

Step 5: Return to the separator layer property page by selecting the Separator tab.  The 
values of D50=0.0253 in. and D85=0.1498 in. are returned for the subgrade.    

Step 6: On the Sieve Analysis property page, check the filtration and uniformity criteria at 
the subgrade/base interface by clicking on the balance icon on the right-hand side.  
Both the criteria generate a Pass rating, which implies that no separator layer is 
required.  

 
The completed separator layer screen is shown in Figure 43.  Note that the summary page 
on the right side of the DRIP screen shown in the figure now states that the base and 
subgrade materials have been defined. 
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Figure 43.  Checking separation criteria. 

Edgedrain Design 
 
Step 1: Select the Edgedrain tab. 
Step 2: Select the Pipe Edgedrain radio button. Click the “Corrugated” checkbox and a 

value of nmanning = 0.024 is displayed.  Type in a value of D = 4 in.   
Step 3: The calculator icon is enabled for calculating the pipe capacity (Q).  The 

computed pipe capacity should read 12,594 ft3/day. 
Step 4: Click on the Lo button to compute the outlet spacing.  This gives an Lo value of    

391.6 ft.  However, this value is based on the default selection of the Pavement 
Infiltration method for the pavement discharge rate (see under “Discharge Rate 
Approach” option list).  Two other methods are given to compute the maximum 
outlet spacing: Permeable Base and Time-to-Drain.  Since the time-to-drain 
method was not used for designing the permeable base we will not examine this 
approach.  For computing the outlet spacing Lo based on the Permeable Base 
approach, select the appropriate radio button from the “Discharge Rate Approach” 
options.  Our previously computed base discharge qd of 44.81 ft3/day/ft appears 
automatically.  This results in a maximum outlet spacing of 281 ft.  Thus, the 
permeable base discharge result is the critical value, so the user should specify an 
outlet spacing of 281 ft.   
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The final edgedrain design screen is shown in Figure 44.  Note the updated summary on 
the left side of the screen shown in the figure.  A printed output summary can be obtained 
by clicking on File | Print Summary menu option. 
 

 
Figure 44.  Pipe edgedrain design and outlet spacing computation 

Example Problem Number 2 
 
Given 
 
The input data are the same as Example Problem No. 1, except that a woven geotextile is 
used for the separator layer and a Hydraway geocomposite edgedrain is present.  
Permeability conditions are critical. 
 
Determine 
 
Calculate the time to drain of the permeable base.  Design the geotextile separator layer.  
Calculate the outlet spacing for the geocomposite edgedrain.   
 
Note:  The roadway geometry and inflow calculations do not have to be performed again. 
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Solution 
 
Sieve Analysis 
 
Step 1: Click on the Sieve Analysis tab in the DRIP client window.  Select the Base radio 

button.  The AASHTO #57 gradation configured in the previous example should 
appear automatically in the grid on the left side of the screen. 

Step 2: Enter the given values for the Unit Weight (130 pcf) and Specific Gravity (2.65) 
of the base.   

Step 3: Compute the porosity n = 0.214 by clicking on the calculator icon.  
Step 4: Select the Water Loss Method radio button to compute the effective porosity.  

This selection is justified since AASHTO #57 is a coarse gradation.  Immediately, 
the “Water Loss” table pops up.  On this screen, an extrapolated passing # 200 
value of 0.5% is displayed.  Select the Silt radio button for the type of fines.  This 
produces a Water Loss value of 76% for gravel.  Select this value with a cursor 
and click OK to transport this value to the Sieve Analysis screen. 

Step 5: Click on the calculator icon adjacent to the effective porosity ne on the Sieve 
Analysis screen to compute this value.  The program computes ne = 0.163.   

 
The final screen for computation of the permeable base material properties is shown in 
Figure 45. 
 
Permeable Base Design (Time-to-Drain) 
 
Step 1: Click on the Permeable Base tab to access the corresponding property page.  

Select the Time-to-Drain radio button.  The values for the design inputs, ne, k, SR, 
LR, and H should already be present from the analyses done as part of the previous 
example and this session so far. 

Step 2: The time-to-drain factor t can be determined based on 50-percent drained or the 
85-percent saturation criteria.  The former is the more conservative for permeable 
bases, so it will be used.  Enter U = 50%. 
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Figure 45.  Performing particle size analysis of the permeable base. 

 
Step 5: Click on the calculator icon adjacent to the variable t to compute it.  A value of 

0.55 hr is returned if the Barber/Sawyer equation is used (default).  The 
Casagrande/Shannon equation yields a value of 0.52 hr.  Both these results fit the 
“Excellent” drainage category.   

 
The final Permeable Base design screen in shown in Figure 46. 
 
Additional Discussion 
 
Clicking on the graph icon to the right of the time to drain variable t generates the 
following sensitivity plots: 
 

• Time to drain (t) versus Degree of drainage (U). 
• Time to drain (t) versus Resultant length (LR). 
• Time to drain (t) versus Resultant slope (SR). 
• Time to drain (t) versus Coefficient of permeability of base (k). 
• Time to drain (t) versus Base thickness (H). 
• Time to drain (t) versus Effective porosity (ne). 
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Figure 46. Time-to-drain computations for permeable base. 

 
Separator Layer Design 
 
Step 1: Click on Separator tab to access the property page. Click on the Geotextile 

Separator radio button. 
Step 2: For conservatism, click the Dynamic Flow radio button for “Soil Retention 

Criteria.”  Also, click the Critical radio button for permeability criteria. 
Step 3: The P200, ksub, CU, D15, and D85 should be retained from the previous screen.  If 

these values are not present, click on the calculator icon in the “Subgrade” 
category box, enter the Georgia Red Clay gradation, compute the particle sizes, 
Dxx, and CU, and enter the given ksub value.  Then click on the Separator Layer tab 
to return to the separator layer property page. 

Step 4: Once all the necessary computations are made, the separator property page should 
have the following values for the variables:  P200 = 31%, ksub = 1 ft/day, CU = 
211.73, and D15 = 5.88e-04 in, D85 = 0.1498 in.  Click on the Woven Geotextile 
radio button in the “Geotextile Separator” category box.  Click on the calculator 
icon to compute AOS = 0.0785 in. and k = 10 ft/day. 

Step 5: Suppose a woven geotextile with AOS of 1/6 in. and a permeability of 100 ft/day 
can be found, type in ksep = 100 ft/day.  Click on the calculator icon to compute 
tmax = 0.069 in. for the geotextile.  This is the maximum thickness of the 
geotextile.  The percent open area should be equal or greater than 4 percent, as 
noted close to the bottom right of the screen. 
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Step 6: Finally, click on the balance icon on the right hand side of the screen to see if the 
chosen geotextile passes all the necessary criteria.  All the criteria checks generate 
a Pass rating for the selected geotextile. 

 
The final screen for the geotextile separator layer design is shown in Figure 47.  

 

 
Figure 47.  Geotextile separator layer design. 

Edgedrain Design 
 
Step 1: Click on Edgedrain tab to access the property page. Click on the Geocomposite 

radio button. 
Step 2: Select the row for the Hydraway edgedrain from the table on the right side.  The 

value of Cg = 1333 ft3/day is automatically returned to the appropriate edit box. 
Step 3: Type in a value of 12 in. for the height of flow zone D1 and 4 in. for the diameter 

of the pipe D2. 
Step 4: Use the time-to-drain method for outlet pipe spacing by clicking on the Time-to-

Drain radio button on the “Discharge Rate Approach” category box.  All the 
necessary time to drain inputs should already appear in the respective variable edit 
boxes from the earlier computation on the Permeable Base screen. 

Step 5: Click the calculator icon to compute Q and Lo.  The program returns Q = 1691.1 
and Lo = 59.4 ft. 

 
The final screen for the geocomposite edgedrain design is shown in Figure 48.  
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Figure 48.  Design of geocomposite edgedrain. 

Example Problem Number 3 
 
Given 
 
The gradations of a permeable base and a proposed aggregate separator layer to be used 
in a project are given in Table 2.  Also given is the gradation of the subgrade soil at the 
project location.   
 
Determine 
 
Determine the need to place a separator layer between the permeable base and native 
subgrade.  If there is a need, determine whether the proposed separator layer is adequate. 
 
Solution 
 
Step 1: Click on the Sieve Analysis tab to enter and store the given base, subgrade, and 

separator layer gradations. 
Step 2: Click the “Include aggregate separator” check box. 
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Table 2.  Gradations of pavement materials. 

 
Sieve Sizes Permeable 

Base 
Subgrade Proposed 

Separator 
Layer 

1 1/2 in 100   
1 in 97.5  100 

3/4 in    
1/2 in   85 
3/8 in 70   
No. 4 47.5  65 
No. 8 15 100  

No. 16 4  40 
No 30   88  
No 40    
No. 50 2.5 68  
No. 100    
No. 200  45 11 

0.001 mm 
(hydrometer) 

 4  

 
Step 3: To enter and save the gradation of the given permeable base, click on the Base 
 radio button on the Sieve Analysis page.  Enter the percent passing information 
 for the permeable base given in Table 2 in the grid provided on the left side of the 
 screen after selecting the Value radio button.  After all the information is filled in, 
 click on the “Add” button under the Material Library category box and save the 
 entered gradation.  Now, by clicking on the calculator icon under the Gradation 
 Analysis category box, the user can compute the percent passing the No. 200 
 sieve, P200, the particle sizes, Dxx (e.g., D10, D12, D15), and the CU and CC values 
 for the permeable base.   
Step 4: Repeat the data entry and analysis performed in Step 3 for the separator and 

subgrade layers.   
Step 5: Once all the gradations are entered and the corresponding properties computed, 

click on the Separator tab to access this property page.  All the relevant Dxx 
values for each of the layers should already appear here.  Under the separator 
layer property page select the No Separator option by clicking on the radio button.  
Then check the permeable base/subgrade interface by clicking on the balance 
symbol under the Criteria category box.  The program indicates that the 
uniformity criterion has not been satisfied.  This implies that a separator layer is 
required.  Figure 49 displays the program screen generated from this calculation. 
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Figure 49.  Final program screen for the No Separator option. 

 
 

 
Figure 50.  Final program screen for the Aggregate Separator option. 
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Step 6: Now choose the Aggregate Separator radio button.  Check the criteria again by 
clicking on the balance icon.  This results in the program generating a Pass rating 
for all the criteria.  Therefore, the chosen separator layer is adequate.  The final 
program screen for this computation is shown in Figure 50. 

Step 7: A plot showing the gradations of the subgrade, permeable base, and the separator 
layer can be obtained by clicking on the graph icon next to the balance icon.  On 
this plot, the upper and lower bounds of the gradation band within which the 
proposed separator layer has to fit to be considered acceptable also appear.  These 
bounds are basically a graphical representation of the design criteria.  The plot can 
be generated on a FHWA power 45 chart by selecting Options | Plot Scale | 
Power 45 command from the Options menu.  Alternately, selecting Options | Plot 
Scale | Semi-log command from the Options menu will result in a semi-log plot.   

 
Figure 51 presents a gradation plot for the design example solved above on an FHWA 
power 45 chart.  Figure 52 presents a semi-log plot of the same example in metric scale 
for comparison.  Semi-log plots are useful in visualization when the gradations range 
from very fine to very coarse material.  However, the Dxx values computed in DRIP are 
based on the power 45 charts.   

 
Figure 51.  Separator layer design shown on an FHWA power 45 plot. 
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Figure 52.  Separator layer design shown on a semi-log plot. 

 
6.0 SENSITIVITY ANALYSIS 

Time-to-Drain 
 
The following plots were developed using the sensitivity plotting functionality of the 
Permeable Base property page for the time-to-drain method.  The sensitivity plots 
presented here can be generated by the clicking the graph icon after the time-to-drain 
parameter t has been computed. 
 
Porosity 
 
In Figure 53 it can be seen that the effect of effective porosity is linear.  This means that 
if the effective porosity is doubled, the time to drain is doubled.  This is logical since 
twice the amount of water will be released from the base course.  However, engineers 
should not yield to the temptation of reducing the effective porosity to reduce the time to 
drain.  It must be remembered that the goal of drainage is to remove as much water as 
possible from the base course.  
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Figure 53.  Time to drain versus effective porosity. 

Permeability 
 
In Figure 54, it can be seen that the effect of the coefficient of permeability is inversely 
proportional to the time to drain.  The more permeable the material, the faster the base 
material will drain.  Also, the effect of permeability on the time-to-drain parameter 
decreases with increasing permeability. 
 
Resultant Slope 
 
As shown in Figure 55, the design procedure is sensitive to the resultant slope, with the 
time to drain decreasing as the slope increases.  This is logical; the steeper the slope, the 
faster water will drain.  The time to drain continues to decrease over the entire range of 
slopes presented.  Theoretically, the base will drain even if the slope is flat; however, it is 
questionable practice to apply the design procedure to flat slopes.   
 
Resultant Length 
 
Figure 56 shows the effect of resultant length of drainage path on the time-to-drain 
parameter.  The relationship is quite linear in the reasonable range of LR (4 m and 
greater). 
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Figure 54.  Time to drain versus coefficient of permeability. 

 
Figure 55.  Time to drain versus resultant slope. 
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Figure 56.  Time to drain versus resultant length of drainage path. 

 
Thickness 
 
The effect of base thickness is plotted in Figure 57.  The time to drain is reduced by 
increasing the layer thickness.  While there is large sensitivity to changes in H when the 
value is very small, the curve tends to reach a point where subsequent increases in H no 
longer have much effect on the time to drain. 
 
Methodology 
 
Figure 58 shows the recognizable plot of time to drain versus percent drainage for both 
the Casagrande/Shannon and Barber/Sawyer methods.  Note that they are very similar, 
actually crossing each other at approximately U=55%.  This is true in most cases. 
 
The major difference in the two methods is shown in Figure 59, which plots time to drain 
versus base thickness for the same data set using each method.  Note the wider variation 
at smaller values of H.  For most reasonable values for base thickness, however, the two 
methods will yield similar results. 
 
Base Thickness 
 
The following plots were developed using the sensitivity plotting functionality of the 
Permeable Base screen for the Depth-of-Flow method.  The sensitivity plots presented  
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Figure 57.  Time to drain versus thickness of permeable base. 

 
Figure 58.  Time to drain versus degree of drainage for Barber/Sawyer and 

Casagrande/Shannon methods. 
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Figure 59.  Time to drain versus base thickness using Casagrande/Shannon and 

Barber/Sawyer methods. 

 
here can be generated by the clicking on the graph icon after the required minimum base 
thickness, Hmin, has been computed. 
 
Permeability 
 
In Figure 60, it can be seen that the effect of the coefficient of permeability is inversely 
proportional to the required minimum base thickness.  As the permeability of the material 
increases, the base will drain faster and thus a thinner permeable base can be used.  As 
the permeability increases, the required minimum base thickness decreases at a 
decreasing rate. 
 
Resultant Slope 
 
As shown in Figure 61, the design procedure is sensitive to slope with the required base 
thickness decreasing as the slope increases.  As is the case for the time to drain, the flatter 
the slope, the slower the water will drain, and thus a thicker base is required to contain all 
the water.  The depth required continues to drop over the entire range of slopes presented.   
 
As was stated previously, the base will drain even if the slope is flat; however, it is 
questionable practice to apply the design procedure to flat slopes. 
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Figure 60.  Minimum base thickness versus coefficient of permeability. 

 
 

 
Figure 61.  Minimum base thickness versus resultant slope. 
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Resultant Length 
 
Figure 62 shows the effect of resultant length of drainage path.  The relationship is linear, 
meaning that if the resultant length is doubled, the required base thickness is doubled.  
This is logical, since twice the amount of water will need to be contained in the base 
course. 

 
Figure 62.  Minimum base thickness versus resultant length of drainage path. 

 
Infiltration Rate 
 
Figure 63 shows that the required base thickness is sensitive to the rate of infiltration, 
with the required thickness increasing as qi increases, as would be expected. While there 
is large sensitivity to changes in qi when the value is very small, the sensitivity becomes 
more linear after H reaches a more reasonable value (greater than 0.15 m).   
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Figure 63.  Minimum base thickness versus infiltration rate. 
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APPENDIX TT.1 – STANDARDIZED NOMENCLATURE 
 

ROADWAY GEOMETRY 
 

Symbol Item         English SI 
 
    S  Longitudinal slope          ft/ft             m/m 
    SX  Cross slope           ft/ft  m/m 
    SR  Resultant slope          ft/ft  m/m 
    LR  Resultant length of flow through base        ft    m 
    W  Width of permeable base          ft               m 
    A  Angle between roadway cross slope and resultant slope    
 
 

                 PAVEMENT INFILTRATION        
 

     qi  Rate of pavement infiltration       ft3/d/ft2        m3/s/m2  
    C  Infiltration ratio         
    R  Rainfall rate           in/hr mm/hr 
    IC  Crack infiltration rate         ft3/d/ft         m3/s/m 
    NC  Number of longitudinal joints or cracks       
    WC  Length of contributing transverse joints or cracks         ft      m 
    CS  Spacing of contributing transverse joints or cracks         ft      m 
    W  Width of permeable base            ft      m 
    kp  Pavement permeability          ft/day  m/sec 
    N  Number of contributing traffic lanes  
 
 

PERMEABLE BASE DISCHARGE 
   

    qd or Qp Permeable base discharge rate        ft3/d/ft m3/s/m 
 
 

OUTLET SPACING 
 

    Q  Pipe flow              ft3/day        m3/s  
    L  Longitudinal length of contributing roadway            ft    m 
    W  Width of contributing roadway             ft              m  
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SOILS 
 
Symbol Item         English SI 
 
    Cu  Coefficient of Uniformity 
    D10  Effective size         mm 
    DXX  Soil particle size        mm 
    γd  Dry unit weight of material        lb/ft3  kN/m3 
      Unit weight of water     62.4 lb/ft3       9.81 kNm3  
    GSB  Bulk specific gravity 
    N or n Porosity 
    Ne or ne Effective porosity 
    VV  Volume of voids 
    VW  Volume of water 
    VT  Total volume 
    WL  Water loss 
    U  Percent drained 
    S  Percent saturation 
 
 

DARCY'S LAW 
 

   Q  Flow capacity of base     cu ft/day m3/s 
   k  Coefficient of permeability       ft/day m/d 
   i  Hydraulic gradient         ft/ft  m/m 
   A  Cross sectional area of flow        sq ft   m2 
   H  Thickness of permeable base           ft              mm 
   VS  Seepage velocity         ft/day m/s 
   V  Discharge velocity         ft/day m/s 
 
 

TIME TO DRAIN 
 

   t  Time to drain            hr   hr 
   T  Time factor      
   m  "m" factor 
   S1  Slope factor 
 
 

   GEOTEXTILE 
 

  O95  Opening size of geotextile in which 95% of the            mm 
        the openings are smaller 
  OXX  Opening size of geotextile      mm   
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PIPE FLOW 
 
Symbol Item        English SI 
 
    Q  Pipe capacity     cu ft/day         m3/s or l/s 
    D  Pipe diameter     in                   mm 
    S  Slope      ft/ft       m/m 
    n  Manning's coefficient 
    A  Flow area     sq ft        m2 
    P  Wetted perimeter    ft  m 
    R  Hydraulic radius    ft             m 
    K  Conveyance        
    V  Velocity     ft/sec             m/s  
                    


